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About Metadata

By simple definition, metadata is data about data. Metadata is structured information
that explains, describes, or gives the location of the primary data, or that otherwise
makes using the primary data more efficient. A wide variety of industries use metadata,
but for the purposes of digital imaging, there are currently only a few technical structures
or schema in use. A schema is a set of properties and their defined meanings, such as
the type of value (for example, date, size, or URL).

File Info

Prior to Adobe® Photoshop® CS2 software, the primary image metadata schema was
File Info, which is nonimage data embedded in image files. Originally deployed by
the International Press and Telecommunications Council (IPTC), this metadata
contains only a few fields of limited text that is used to help organize and distribute
photographic images for newspaper publishing. File Info, which is the Photoshop
implementation of the IPTC specification plus additional data fields, defines both the
storage format and the actual metadata. Text fields in the current specification include,
but are not limited to, Caption, Caption Writer, Headline, Special Instructions,
Keywords, Category, Supplemental Categories, Urgency, Byline, Byline Title, Credit,
Source, Object Name, Date Created, City, Province-State, Country Name, Original
Transmission Reference, and Preserve Additional Information. Mark As Copyrighted
and URL are additional fields beyond the IPTC specification. Photoshop CS2 and
Adobe Bridge incorporate the new IPTC for XMP specification in addition to legacy
IPTC metadata.

The IPTC fields allow only a relatively small amount of text information to be embedded
within the file, but it is critical that this information moves through publishing systems
locked together with the file. This embedded information is critical for the thousands
of digital images used in major newspaper companies. Surprisingly, a large number of
Photoshop users don’t realize that these metadata fields exist. Photographers routinely
send out digital images without even marking them as Copyrighted or embedding
simple ownership or contact information.

EXIF

Several years ago, a group of major photographic manufacturers, in conjunction with the
Japan Electronic and Information Industries Association (JEITA), developed a metadata
schema called Exchangeable Image File Format (EXIF). This schema is designed to embed
in a digital capture—right at the moment of exposure—information relating to the
camera’s function and image parameters, and additional miscellaneous information.

Unfortunately, the various schemas currently used in image file metadata do not yet meet
the explicit needs and desires of imaging artists and photographers. For EXIF or any
additional schema to reach broad adoption and acceptance, the creators of digital images
must be brought into the process of designing and specifying metadata implementations.
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XMP framework

At Seybold San Francisco in the fall of 2001, Adobe Systems Incorporated announced a new
technology initiative called Extensible Metadata Platform (XMP). XMP is a common metadata
framework that standardizes the creation, processing, and interchange of document metadata
across publishing workflows. Adobe has also committed to the World Wide Web Consortium
(W3C) standards, including Extensible Markup Language (XML). Thus, XMP is XML-compatible.
For the future of metadata and its usefulness to photographers and imaging artists, XMP holds
the promise of providing a significant and extensive platform for a wide array of various metadata
implementations. Both public and private metadata schemas can use a widely adopted framework
schema that will enable a rich and extensive use of metadata for critical technologies, such as
Digital Rights Management (DRM) and Digital Asset Management (DAM).

Adobe Creative Suite 2, which includes Adobe Photoshop, Adobe Illustrator®, Adobe InDesign®,
Adobe Acrobat®, and Adobe Bridge, has achieved broad support for XMP across most Adobe
applications. Photoshop CS2 and Bridge in particular offer an extensive deployment of XMP.

Present and future possibilities of metadata

Because of the lack of coordination between manufacturers and organizing bodies, much of the
potential of metadata remains unrecognized. Following are examples of metadata and how it can
help photographers, both now and in the future.

You can use the File Info dialog box to view and append or replace metadata in image files.

'VB7J9512.DNG 'VB7J9983.DNG
| Descrpion ® | Descrpion ®
| | Camera Data 1 I Camera Data 1
|| Camera Data 2 Document Title: Camera Data 2 Document Title: Iceberg in Antarctica
Categories Categories
Author: Author: i
Histary wuthor: History wthor:  Copyrighted by Jeff Schewe
IPTC Contact Author Title: IPTC Contact Author Title: Photographer
IPTC Content — IPTC Content —
IPTC I Description: IPTC | Description: Iceberg shot in Antarctica in Cierva Cove during a Zodiac cruise.
mage | mage Approximate latitude and longitude: 64°090°S 61°07'W
IPTC Status | IPTC Status
Adobe Stock Photos : Adobe Stock Photos
Origin Description Writer: | Origin Description Writer: Jeff Schewe
Acvanced Keywords: Adianced Keywords: Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove;
| Landscape
! Commas can be used to separate keywords ! Commas can be used to separate keywords
Copyright Status:  Unknown [ | Copyright Status: | Copyrighted [ :]
Copyright Notice: | Copyright Notice: ©2005 by Jeff Schewe
| ALL RIGHTS RESERVED
Copyright Info URL: | Copyright Info URL: http://www.schewephoto.com
GoTo URL.. (GoToURL.. )
Created: 12/6/05 10:09:52 AM | Created: 12/6/05 10:09:52 AM
Modified: 12/6/05 10:09:52 AM Modified: 12/6/05 4:50:03 PM
Powered By Application: | Powered By Application:
Xxmp Format: image/tiff | Xxmp Format: image/tiff
| |
) | |

The basic File Info dialog box in Photoshop CS2 (left) and the fields entered with metadata (right)

Embedded metadata can be in XMP form and is also aliased to other schemas for backward com-
patibility. Some of the information, such as the IPTC metadata, is editable; other information is
read-only. The creator of an image file should adopt a policy regarding whether subsequent users
should replace or simply append existing metadata. For example, it would be inappropriate for
users who didn’t create the image file to remove or replace the Author information or change an
image marked Copyrighted to Unknown.
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You can view a variety of metadata for any file in the File Info dialog box, including IPTC, EXIF,
Camera Raw settings (for raw files), and more. You can even view the saved edit history of an
image if you use the history tracking feature in Photoshop CS2, and the history is embedded in

the file as metadata.

VB7)9512.DNG

VB7)9512.DNC

Description Camera Data 1 ® Description Advanced ®
Camera Data 1
Camera Data 2 Make: Canon Camera Data 2 ¥ http://ns.adobe.com/camera-raw-settings/1.0/ m
Categories Model: Canon EOS-1Ds Mark II Categories crs:Version: 3.3x43
i i :RawFileN : VB7]9512.DNG
Ristony Date Time: 2005-12-06T10:09:52-06:00 History ErER MR e IR
IPTC Contact IPTC Contact crs:WhiteBalance: Custom
IPTC Content Shutter Speed: 1/1600 sec IPTC Content crs:Temperature: 5400
IPTC Image Exposure Program: Aperture priority IPTC Image crs:Tint: +4
IPTC Status IPTC Status crs:AutoExposure: True
Adobe Stock Photos F-stop: /6.3 Adobe Stock Photos arsiExposure: +0.65
Origin Aperture Value: /6.3 Origin crs:AutoShadows: True
Advanced ers Shadows: 13
Max Aperture Value: /5.0 crs:Brightness: 38
) crs:Contrast: +78
ISO Speed Ratings: 100 SeSaation0
v
Focal Length: 100.0 mm crs:Sharpness: 25
crs:LuminanceSmoothing: 0
Lois 2RI crs:ColorNoiseReduction: 25
Flash: Did not fire crs:ChromaticAberrationR: 0
No strobe return detection (0} s ChromaticALaTationE:(D)
c f flash L crs:VignetteAmount: 0
‘ompulsory flash suppression (2) ¢rs:ShadowTint: 0
Flash function present crs:RedHue: 0
No red-eye reduction crs:RedSaturation: 0
:Gi Hue: 0
Metering Mode: Pattern crsshreentiue: 1
crs:GreenSaturation: 0
crs:BlueHue: 0 a
— — crs:BlueSaturation: 0 M
Xxmp Xmp (" Replace... ) ( Append.. ) ( Save.. ) Delete
] )

Some of the EXIF metadata fields (left) and the recorded Camera Raw settings (right).

Some metadata is known as public data and some of it is referred to as private data. While there
are standards for all public metadata fields, the private fields are largely undocumented. That is
one of the problems associated with some of the private maker notes embedded in proprietary
raw digital camera files.

IPTC Contact
IPTC Content
IPTC Image
IPTC Status

New to Photoshop CS2 and Adobe Bridge is the addition of IPTC Core, four custom metadata fields that conform
to the new IPTC for XMP.
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VB7J9512.DNG VB7)9512.DNG

Description IPTC Contact ® Description IPTC Content ®
Camera Data 1 Camera Data 1
Camera Data 2 Use this panel to record the photographer’s contact information. Camera Data 2 Use this panel to describe the visual content of the image.
Categories Creator Copyrighted by Jeff Schewe [} Categories Headline |
History History
IPTC Contact Creator's Job Title |Photographer - IPTC Contact
IPTC Content
e AL CIESa8 624 West Willow St. =y Description lceberg shot In Antarctica in Cierva Cove during a Zodiac cruise ]
mage mage Approximate latitude and longitude: 64°090°S 61°07'W
IPTC Status IPTC Status
Adobe Stock Photos Adobe Stock Photos
Origin City 'Chicago Origin
Advanced . Advanced
State/Province [||linoi Keywords* [Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove ]
Postal Code [g0g14
Country [Jsa
IPTC Subject Code* iC}
Phone(s)

E-Mail(s) info@schewephoto.com Subject codes are defined at http://www.newscodes.org

Description Writer Jaff Schewe o]

Website(s) http://www.schewephoto.com

* Multiple values may be separated by a comma or semicolon.

Metadata templates can populate multiple fields at ance.

Access metadata templates from the upper right comer of this dialog.

Support and updates for these IPTC panels can be found at http: / fwww.iptc.org/iptcdxmp Xn n'p

G ) @0 G ) G0

VB7J9512.DNG VB7J9512.DNG
Description IPTC Image © Description IPTC Status ®©
Camera Data 1 Camera Data 1
Camera Data 2 Use this panel for formal descriptive information about the image. Camera Data 2 Use this panel to record workflow and copyright information.
Categories Date Created 126,05 T} Categories Title '|ceberg in Antarctica ]
History History
IPTC Contact Intellectual Genre IPTC Contact Job Identifier |
IFTC Content IPTC Scene* i} IFTC Comtent Instructions |
IPTC Image IPTC Image
IPTC Status IPTC Status
Adobe Stock Photos Adobe Stock Photos
o Scene values are defined at hutp:/ fwww.newscodes.org Origin
Advanced Advanced e o
Location ‘antarctica O
Source |
City ]
Copyright Notice ©2005 by Jeff Schewe i
State/Province ) ALL RIGHTS RESERVED
Country Antarctica |
150 Country Code .
Rights Usage Terms ALL RIGHTS RESERVED, no reproduction in any form is authorized without | [+
Country codes may be either 2- or 3-letter codes as defined by the ISO 3166 standard. the express written consent of Jeff Schewe
* Multiple values may be separated by a comma or semicolon.
Powered By Powered By
xmy xmy

Comai ) 0 el ) G0

IPTC Core has new fields for use with digital images.
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Embedding metadata image by image isn’t particularly productive. While IPTC metadata can be
embedded using Actions and Batching operations in Photoshop, it’s useful and more productive
to use Adobe Bridge to add metadata to multiple files at once.

P00

Antarctica-card - Adobe Bridge

@ » Antarctica-card

Folders

Metadata

Filename
Document Kind
Date Created
Date File Created
Date File Modified
File Size
Dimensions
Resolution

Bit Depth

Creator

Creator: Job Title
Creator: Address
Creator: City
Creator: State/Province
Creator: Pastal Code
Creator: Country
Creator: Phone(s)
Creator: Email(s)
Creator: Website(s)
Headline
Description

IPTC Subject Code
Description Writer
Date Created
Intellectual Cenre
IPTC Scene
Location

City
State/Province
Country

150 Country Code
Title

Job Identifier
Instructions
Provider

Source

t VB7I977E.DNG
 Camera Raw

© 12/6/05, 11:40:26 AM
t 1/18/06, 6:59:09 PM

* Today, 2:17:21 PM

© 11.46 MB

© 4992 x 3328

* 240 dpi

i 18

B e

Bleeseoonhohoneh oot ehehot et
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4k 47 items, 14 hidden, 1 selected

Image selected in Adobe Bridge

Volumes/MAIN-ARRAY/ Antarctica-card

Unfiltered ~ ﬁ ﬁ f‘ | a ‘B
i (New Window )
‘ i
wn..‘_.[‘m‘c ‘ . k-1
=, >
-
2 B N
A
v

In the File Browser, there are movable panes that contain the fields of metadata that you have

chosen to show. You can control which fields are visible by choosing them from the Metadata
Display Options in the Edit menu of the File Browser.

Preferences

General

Metadata

Labels

File Type Associations

Advanced
Adobe Stock Photos

Metadata

Filename
Preserved Filename
Document Kind
Application

Date Created

Date File Created
Date File Modified
File Size
Dimensions
Resolution

Bit Depth

Color Mode

Coler Profile

Label
Rating
Notes

1 S NN ENTEN NN RN ES[ENJENIENIEN

Creator

Creator: Job Title
Creator: Address
Creator: City
Creator: State/Province

v C

Powered By

Xmy

 Hide Empty Fields

) G

Select fields you wish to see in the Metadata preferences in Adobe Bridge.
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2]

Metadata
Filename VB7J9545.DNC Creator # Exposure 1/1000 s at f/8 Raw Filename I VB7J9545.DNG
Preserved Filename : Creator: Job Title rd Exposure Bias Value 1 -033 ‘White Balance © Custom
Document Kind Camera Raw Creator: Address & Expasure Mode Auta Temperature 5400 K
Application : Creator: City r'd Exposure Index : Tint -l
Date Created 12/6/05, 10:44:16 AM Creatar: State/Province & Expasure Pragram Aperture priority Exposure - +1.10
Date File Created © 1/18/06, 6:58:20 PM Creator: Postal Code & Brightness Value : Shadows * 30
Date File Modified 1/19/06, Creator: Country & ISC Speed Ratings 100 Brightness 19
File Size t11.22 M8 Creator: Phone(s) & Focal Length ! 70 mm Contrast - +BS
Dimensions 4992 x 3328 Creator: Email(s} s Focal Length in 35mm Film Saturation -45
Resolution © 240 dpi Creator: Websitefs) & Lens | 70.0-300.0 mm Sharpness s 23
Bit Depth 16 Headline g Max Aperture Value fla.6 Luminance Smoothing )
Color Mode * RGE Color Description & Software : Color Noise Reduction  © 25
Color Profile ProPhoto RGB Keywords EXIF Copyright ©2005 by Jeff Schewe Chromatic Aberration R/C : 0
Label : IPTC Subject Code & . ALL RIGHTS RESERVED Chromatic Aberration B/Y © 0
Rating || | Description writer & LIRS Vignette Amount 0
s il e » Date Time 12/6/05, 10:44:16 AM \ignette Midpoint
Supports XMP Yes v Intellectual Genre & Date Time Qriginal + 12/6/05, 10:44:16 AM Shadow Tint )
Cal
Selected fields appear as a scrollable list in the Metadata panel in Adobe Bridge.
You can edit metadata directly in the fields that allow editing (such as IPTC) either image by
image or in selected groups. However, it’s more productive if you create and save custom meta-
data templates.
[0 B8 Antarctica-card - Adobe Bridge
—
e ) = =
@ > oA of|als
Folders | Camera Data 1
Metadata Camera Data 2 Document Title: Iceberg in Antarctica |
7 File Properties Categories -
Filename History Author:  Copyrighted by Jeff Schewe |
Document Kind | =
IPTC Contact : [
Date Created B | Author Title: \Photographer
. onten
Doe File{Created | — Description: Iceberg shot in Antarctica in Cierva Cove during a Zodiac cruise. i}
Darte File Madified mage Approximate latitude and longitude: 64°090'S 61°07'W
File Size | | IPTC Status
:;T;::z:s | Adobe Stock Photos
8it Depth Origin Description Writer: _leﬁ Schewe |
¥ IPTC Core | Advanced Keywords: Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove [+
Creator
Creator: Job Title |
Creatar: Address
Aty | ! Commas can be used to separate keywords
Creator: State/Provil S e
Creator: Postal Cod‘
Creator: Country Copyright Status: = Copyrighted B
Creator: Phone(s) | . .
Creator: Email(s) Copyright Notice: ©2005 by Jeff Schewe [+
Creator: Website(s) | ALL RIGHTS RESERVED
Headline
Description | =
IPTC Subject Code Copyright Info URL: http:/ /www.schewephoto.com |
Description Writer | =

Date Created
Intellectual Genre |

EIC Scene Created:

é‘i’;‘“"” | Modified: 12/6/05 11:40:26 AM
State/Province | Powered By Application:

Country xm p- Format:

SO Country Code |

Instructions
Provider : &
Source : &

4k 47 items, 14 hidden, 1 selected

The figure above shows the File Info dialog in Adobe Bridge. You can fill it out manually as I've done here and then
save it out as a metadata template to apply to multiple images.

Title
job identifier | ( cancel ) € oK)
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To create a custom template, first select an image in the File Info dialog box. Then choose File >
File Info and fill in the fields that can be applied to a wide variety of the images you’ll be working
on, such as Copyright Status, Author, and Copyright Notice. Choose Save Metadata Template
from the pop-up menu, and then close the dialog box. You can name the template in the Save
dialog box that appears. The template will then be saved and will appear in the pop-up menu of
the File Info dialog box and also in the File Browser.

£ SCHEWE-2005 Save Metadata Template

Save Metadata Template... Template Name: Antactica-Cierva Cove
Delete Metadata Template..."

| c | E—SH
Show Templates... C i )

Saving a custom metadata template (left) with a descriptive name (right)

Bridge File Edit lmﬂ Label View Window Help

Batch Rename... {38R

|
Version Cue

Photoshop Services

Photoshop
Illustrator
InDesign

v yrwvywy v v

Cache

Import from Camera...
Append Metadata » Antarctica-Cierva Cove .
| Replace Metadata > SCHEWE-2005 5

A saved template appears in the Edit menu of Adobe Bridge.

After you select the template, you’ll be alerted that you are applying metadata to multiple
selected files. Choose Don’t Show Again if you don’t want to see the alert the next time you
apply the template.

Adobe Bridge
You have selected multiple files. When you
' apply your edits, all files in the selection will be
ny affected. Do you want to continue?

Bridge returns an alert when you apply a metadata template to multiple files.

If you are adding metadata to raw files, note that the data will be stored only in separate sidecar
files in the same folder as the file or in the Camera Raw database, depending on your preferences.
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Camera Raw and Photoshop CS2 embed the metadata directly in the processed file when it is

saved. Note also that all public metadata fields will also be in the file, including EXIF, Camera

Raw settings, and image history (if you selected that option).

666

metadata-screens - Adobe Bridge

~J L [3 Antarctica-card

Folders

Metadata

Creator

Creator: Job Title
Creator: Address
Creator: City

Creator: State/Province
Creator: Postal Code
Creator: Country
Creator: Phone(s)
Creator: Email(s}
Creator: Website(s)

Headline
Description

Keywords

IPTC Subject Code
Description Writer
Date Created
Intellectual Genre
IPTC Scene
Location

City
State/Province
Country

IS0 Country Code
Title

Job Identifier
Instructions
Provider

Source

Copyright Motice

Rights Usage Terms

* Copyrighted by Jeff Schewe
* Photographer

* 624 West Willow St.
 Chicaga

* lllinais

© 60614

LUsA

* info@schewephoto.com
* hrtp:/

www.schewephoto.com

* Iceberg shot in Antarctica in

Cierva Cove during a Zodiac
cruise. Appraximate
latitude and longitude:
6470905 61°07'W

* {Multiple values)

* Jeff Schewe

© Antarctica

* Antarctica

* lceberg in Antarctica

* ©2005 by Jeff Schewe

ALL RICHTS RESERVED

* All Rights Resered-no

reproduction of any kind
without express written
persmission from Jeff

B &

nfikered > B 0 2 | G | &

B YRR R RRRRS

% YRR R R R R YR

JVolumes /MAIN-ARRAY  Antarctica-card/

VETJ9B3EDNG &=

VE7)..DNG S8

VETL..DNG S &

VET)..DNG =&

VE7)..DNG S E

VE7)..DNG S8

VE7)..DNG B8

VE7L...DNG &8

VETJ9BTE.DNG &

VE7)..DNG S8

VE7J9800.DNG &

VB7J9501.DNC &

VB7)9502.0NC &

VE7J9826.DNC &2

VB7)...DNG &8

VB7J9932.DNG &

VB7J93B2.DNG &

4F 47 items, 14 hidden, 47 selected

Embedded metadata in selected files

ve7)..DNG S8

ve7)..oNG S8

After you apply the template, all of the images will have updated metadata from the template.

You can still edit individual fields (for example, adding keywords) on an image-by-image basis.

% © VB7)9983.ONG @ 33.3% (RGB/8")

vB7)..ONG S8

VB7)9512.DNC

Description Description ®
Camera Data 1
Camera Data 2 Document Title: Iceberg in Antarctica o
Categories
Author: i ]
. uthor: |Copyrighted by Jeff Schewe
IPTC Contact Author Title: Photographer o
IPTC Content ==
PTC | Description: Iceberg shot in Antarctica in Cierva Cove during a Zodiac cruise. ]
mage; Approximate |atitude and longitude: 64°090°S 61°07'W
IPTC Status
Adobe Stock Photos
Origin Description Writer: Jeff Schewe ]
Advanced Keywords: Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove ic]
! Commas can be used to separate keywords
Copyright Status: | Copyrighted %
Copyright Notice: ©2005 by Jeff Schewe
ALL RIGHTS RESERVED
Copyright Info URL: Thttp: //www.schewephoto.com [}
Go To URL...
Created: 12/6/05 10:09:52 AM
Modified: 12/6/05 10:09:52 AM
FoweredBy Application:
Xmp Format: image/tiff
(-

This processed raw file (left) has had the common metadata (right) entered and saved as part of the raw processing.
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Conclusion

Metadata has phenomenal potential for the photography industry. For example, sup-
pose two photographers are on assignment and shoot from the identical position with
identical lighting. For all practical purposes, the images would be identical, and you
would be unable to differentiate who shot which image. By using metadata, you would be
able to see the serial number of the camera body and the owner’s copyright, providing
conclusive proof of ownership.

By using metadata to embed keywords in the images you intend to place in stock librar-
ies, you can reduce or elimate the large amounts of time and money currently spent
adding keywords. The current cost of placing a film-based image into a stock library
and duplicating it can be as high as $140.00 per image. Reducing the amount of time
that an agency spends applying keywords, along with solving other image identification
problems, could drastically reduce the actual cost of placement within a system. Adding
rich keywords and additional information actually makes an image more valuable.

Photographers and imaging artists can take advantage of metadata for many aspects
of their imaging businesses. They can incorporate licensing information for an image,
along with the password security for opening the file, into a metadata schema. Imagine
being able to embed a unique image identification that will travel wherever the image
goes—Photoshop CS2 does that right now. Users could generate and complete invoices
and transactions by using metadata or billable time while image processing, or to track
exactly what was done to an image file, and when.

Additional resources about metadata

Adobe XMP
www.adobe.com/products/xmp/main.html

Dublin Core Metadata Initiative
www.dublincore.org

Japan Electronic and Information Industries Association (EXIF)
www.jeita.or.jp/

International Press Telecommunications Council (IPTC)
www.iptc.org

IPTC for XMP
www.iptc.org/IPTC4XMP

World Wide Web Consortium (XML)
www.w3.0rg
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FOR MORE INFORMATION

For a comprehensive overview of Photoshop CS2,
please visit www.adobe.com/products/photoshop/
main.html.
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